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Google Docs

There are many new online word processing tools. Google Docs,
for example, is a free suite of word processing, spreadsheet, and
presentation applications designed for collaboration. Because the
resulting work is stored online, students can access their work
from any location—school, library, or home. A Google account
is required, but it is a no-cost alternative to students using
different word processing software applications and having to
e-mail their scripts to each other. Because Google Docs also has
a presentation tool, students can use that as a stored collaborative
space simulating a storyboard tool.

Google Docs also provides the Google Gears plug-in, a way for
users to work on their documents stored by Google Docs even
when they are offline. This is great news for those teachers who

have students working on digital stories where access to the
Internet is not always available.
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Google Tools for Digital Storytelling

Google Docs
http//docs.google.com
Account Sign-up: www. google.com/accounts/NewAccount
Google for Educators: www.google com/educators
Help Page: hitp://docs google.com/support

Google Docs is a free suite of online word processing, sprfead.sf‘weet,
and presentation applications that can be used to create mdwud.ual
or collaborative documents, spreadsheets, and presentations with
as many features as most desktop applications. These created '
products can be downloaded to your computer 1o be used offline,
or stored and shared with others online, To use them, all you have
to do is sign up for a free Google account, and you can access the
suite, the instructions, a video tutorial, and a special online section
with shared ideas for educators.

Google Gears

http://gears.google.com

Help Page: http./tinyurl com/5mjm4u
If you want to work with the products you create with Google Docs
when you're not online, you will be prompted to install a small ;‘Jlug-
in, called Google Gears. It is easy and free. Just follow the directions
contained on the Goggle Docs Help page.

Google Notebook
http://google.com/notebook

Notebook Tour: www.googie com/googienotebook/tourt.htmi

Google Notebook is an online tool designed to gather and store
information from web pages. These items can be snippets of text,
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images, links (URLs), and text that you will want to type in and save.
Itis meant to simulate a physical notebook with a pocket for storing
items. Teachers and students can use this handy tool privately or as

a shared resource for group projects such as digital storytelling.

Google Image Scarch

http://images.google.com

Google Image Search service is a way to locate images stored on
web pages quickly by performing a keyword search. It should be
noted that copyright rules apply to using these photographs and
images no matter where they are located. Students should be
instructed to look for the owner of the image and to find a way to
contact them if permission is needed,

Google Maps

http:/maps.google.com

Google Maps mapping service is an online tool for displaying
maps of locations near and far. Place-based digital stories rely

on the use of maps so that students can relate the visual map
with the locations in the story. Ever improving, Google Maps is a
wonderful and useful classroom tool. All stories, real or imagined,
have locations to be explored, and this can help students develop
essential geography skills.

Shared Media Resources

Many resources for muitimedia are available under Creative
Commons licenses, discussed in Chapter 1. Some are in the
public domain or are offered under an open content license,

meaning that they are freely available for use in student projects.
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Educators, too, are taking photographs, making music and
sounds, and applying the least restrictive Creative Commons
license to their work so that others can use it legally. This

way, if one teacher takes a photograph of an outdoor public
monument, the photo can be shared with other educators
whose students are writing digital stories about that monument
and never had the opportunity to visit it in person. The most
commonly used repository is hosted by Tech4Learning and is
called Pics4Learning (www.pics4learning.com). Photographs
are grouped by subject. If you don't find what you're looking for,
you can search the collection. Information is also provided at
Pics4Learning to assist students with citation.

In contrast, morgueFile’s repository of high-resolution
photographs (http://morguefile.com) can be searched by
keyword, but each search result should be examined carefully
for appropriate school use and for copyright information. This

is also true for images in Google’s Image Search (http://images.
google.com). If a student finds a photograph they'd like to use
for their project, they must seek permission (by e-mail) from the
person who owns it.

Recently, The Library of Congress and Flickr have teamed up

to host photographs that have “no known copyright restrictions.”
This growing endeavor, called The Commons, (www.flickr.com/
commons/) is an example of collaboration to make it easier to
view historical photographs. Other museums and repositories

of photographs with no restrictions on them may follow. This is
great news for digital storytellers whose projects revolve around
history and culture.
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The Commons—Historical Photo Archive

An exciting development for teachers, students, historians,
archivists, librarians, and other digital denizens is the recent
partnership formed between the Library of Congress and Flickr,
The result is a giant collection of historical photos with “no
known copyright restrictions.” The partnership was launched as
a pilot project in January of 2008 with a collection of about 1,500
photos selected from over a million photos from the Library of

Congress. This archive is known as The Commons (www.flickr.com/
commons/).

Sample Commons photograph

Users can tag photos freely, and they can also contribute photos.
Although the collection is still growing, this brilliant idea has caught
on like wildfire. People spend hours examining, commenting on,
and tagging photos for use in all kinds of projects. If you visit their

site you'll see that today there are as many as 20 million tags on this
Flickr site,
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Also, take a look at the cultural artifacts (moving images, live
music archives, and audio) at the Internet Archive {www.archive.
org) to find project-appropriate resources. This site also offers

a search forum bulletin board on the front page, with date and
time of the post.

The Open Video Project (www.open-video.org) holds only video
clips, but is likewise education-friendly. This site is sponsored
by the University of North Carolina. The listings, organized by
genre, provide length, color, and sound details.

Podcasting and Audio Files

Podcasting is a way to share and receive audio broadcasts
through the Internet. Using digital media files, podcasts can
be an effective way to tell digital stories. Sound clips and short
musical clips are being created and posted via podcasts on
websites with the expressed intent of sharing the material with
students. Use caution with any of these sites because the word
“free” is beginning to mean different things to different people.
Check also for rights to educational use.

Freeplay Music has an excellent libary of clips of music in
different lengths, perfect for digital storytelling, but these clips
may not be broadcast. You may not post them to the web as
part of your project or in podcasts—as many educators once
thought—even in abbreviated format, but they are great for
in-classroom projects.

Educators may also be interested in two music and sound clip
sites that contain content licensed under Creative Commons.
ccMixter (http://ccmixter.org) is a community music site
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| -
featuring music remixes licensed under Creative Commons. e m o Rl o o o
The Freesound Project (www.freesound.org) is a collaborative :‘ mEmml == (@ =
database of Creative Commons licensed sounds (not music) for o 7 '::3]! -
use in audio tracks and podcasts. P
v =]
7/ Lo |
Additional sites are listed in the Resources section at the end of ~ = ¥,
this chapter. ; e =]
7 Gpazn |
] revterm (bl =
lltustration Tool ,; Breme
Tech4 Learning, a popular educational software company, 8,
created Twist (www.tech4learning.com/twist/), an affordable o
vector-based illustration tool to be used in Grades 3-12 to create
scientific diagrams and other drawings for digital stories that - 1 rallo

have their curriculum connection to science and technology. Example of Twist project screen
Students can design images that can be easily exported to
common graphic formats, then easily inserted into other

it , . Resources
applications to create the story’s technology connection.

A quick look at the company’s website will demonstrate Timelines
the flexibility of this application. Twist sample files can be
downloaded and opened in this application as a start for digital
storytelling projects. Younger students in Grades 3-5 can create
a single image to be placed in the digital story as part of a project
or to be used as a story starter to open the conversation between
teacher and student within a curriculum area. In addition,
educators around the world have freely donated images and Timeline Generator: mterialtimelines
photographs that can be used as starters for the background of wwwteach-nology.com/web_tools/materia

Twist illustrations.

Chronological Timeline: www.teachervision.fen.com/
graphic-organizers/printable/6301.html

Dipity: www.dipity.com

ReadWriteThink Interactive Timeline:
www.readwritethink.org/materials/timeline
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Timeline Graphic Organizer:
www.eduplace.com/graphicorganizer/pdf/timeline.pdf

XTimeline: www.xtimeline.com

Concept Mapping
Gliffy: www.gliffy.com

Inspiration software: www.inspiration.com

Storyboards

Comic Life and Comic Touch software: htip://plasq.com/products
Print Free Storyboards: www.pdfpad.com/storyboards

Storyboard Example:
www.sdcoe.k12.ca.us/SCORE/actbank/tboard.htm

Storyboard Planning PowerPoint Template:
www.alice.org/bvw03/TAweb/storyboard _template.ppt

StoryBoard Pro Software:
htip://movies.atomiclearning.com/k12/storyboardpro

StoryBoard Pro free tutorials:
http://movies.atomiclearning.com/k12/storytellingindex.shtml

Storyboarding: A Recipe:
www.storycenter.org/memvoice/pages/tutorial_3.html

Shared Resources for Image and Video
Pics4Learning: www.picsdlearning.com
morgueFile: http://morguefile.com
Google Image Search: http://images.google.com
The Commons: www.flickr.com/commons
Internet Archive: www.archive.org

The Open Video Project: www.open-video.org
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Audio Clips
PodSafe Audio: www.podsafeaudio.com

Partners in Rhyme: Free Sound Effects:
www.partnersinrhyme.com/pir/PIRsfx.shtml.
Note that nany sound effects are royalty free rather than free—a
license fee must still be paid.

Freeplay Music: www.freeplaymusic.com

Musopen: www.musopen.com
Free public domain classical nusic.,

ccMixter: http://cemixter.org
A community music site featuring music remixes licensed under
Creative Contmons.

The Freesound Project: http://www.freesound.org
A collaborative database of Creative Commons licensed sounds.
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Learningin Hand

On his Learning in Hand website (http://learninginhand.com),
education censultant Tony Vincent offers a workshop for educators
and posts his resources for moviemaking. You will find Tony's
handouts, storyboard page, and online presentation useful for other
video-based projects in addition to his ideas for storyteliing.

learnin nhand womE L
W reamingrtand

Make Marvelous Movies

Tony Vincent's movie-making resources web page

Terrific for computer users on all platforms, Tony's handouts are a
valuable resource. He offers experience in the classroom and has
taught his own students good video and still camera technigues, no
matter what level of camera experience they may have had.
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Photo Story and Movie Maker

Not to be outdone by Apple’s successful desktop video-editing
application, Microsoft offers Photo Story and Movie Maker, two
free tools for digital storytelling that are already installed on
computers running Windows XP or Windows Vista. If you find
they are not installed, both are freely available from Microsoft’s
website for quick download. Photo Story can be found at
www.microsoft.com/windowsxp/using/digitalphotography/
photostory/ and Movie Maker at www.microsoft.com/
windowsxp/downloads/updates/moviemaker2.mspx.

The primary difference between Photo Story and Movie Maker is
that Photo Story does not allow importation of video clips. But,
you can make a digital story in Photo Story, render it to movie
format, and import it into Movie Maker. You can add digital
story elements either before or after this imported movie. Of
course, you can use either product to complete your digital story.

Photo Story

Photo Story shines as a digital storytelling application, in part
because it creates video from still digital images. It is also a
favorite choice of educators for ePortfolio creation because, for
example, they can use scanned or digital photographs taken of
paper projects and then import the photos into Photo Story.

Another advantage of Photo Story is that you can attach a
microphone to your desktop computer or laptop and easily
record and store short narration. Photo Story also offers
copyright-free music in many styles, which is easily applied to
your project for a nice effect. For busy teachers who don’t have
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the classroom time to record and edit small narrations, or to
hunt for just the right noncopyrighted music, Photo Story is a
great resource.

Following is a tutorial that will introduce you to the capabilities
of Photo Story.

Photo Story Tutorial

Imagine that your students are waorking with the local Chamber
of Commerce to produce a print and online project with a focus
on family-owned businesses. As part of this, your students

must produce a digital story about the history of each business,
demonstrating to a community audience how each business has
evolved over time. Your students have scanned old photographs
and brochures, enhanced the resulting images, and conducted
and recorded oral interviews from people in the community who
worked for and lived near the business. They have developed

a timeline and created a simple storyboard as a first step in the
production process. After completion of this part of the project,
students will take photographs of the business as it exist today,
and then use Photo Story to blend together the history, the oral
interviews, and the pictures of the current business into a single
production. The resulting digital story will show changes in
perspectives over time. This project, by the way, meets national
and state standards in history. At the same time, it helps students
connect to their own community.

In the tutorial that follows, screenshots and instructions are for
Photo Story 3. Both older and yet-to-be-released versions will differ
somewhat, but should maintain the same basic functionality.,
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Importing photos for the project

1.

Students place scanned and edited photos and
documents into a folder titled with the name of
the project.

Students open Photo Story, and at the first on-screen
choice select Begin 2 New Story,

Students then ciick the Next button.

The next screen, called the “Import and arrange your
pictures” screen, asks students to Import Pictures.

When students click on the Import Pictures button, the
file browser opens, allowing them to import one, some,
or all of the photos into the folder.
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Importing photos into Photo Story
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Arranging and editing photos

6. Next, students bring the stifl images into a timeline,
where they can be easily rearranged by dragging or be
deleted. Photo Story provides tools for simple editing
techniques. Go to the Edit menu or find other tools
located directly underneath each image.

7. Students may need assistance in order to understand
the process of removing black borders.

8. At this point, it is critical that students name and save
the project. This is not the same as rendering a movie,
as that comes later in the process.

The buttons at the bottom of each screen allow
projects o be saved frequently, and also permit
students to return to a previous screen if needed.

E‘ Phota Stary J for Windows

Import and arrange your pictures

Select the pictures you want Lo Use N your Sory,
arvd thven ark afage i I erdér oh the Him strig,

[ oot P, ]

|_'.i,| Bomervs black borders.

9 = T —

e s
REHE =TEEP=E G

[ oo ) [ sempoma. | [eem ) wet> ][ _crm )

Arranging photos in Phato Story

TO | DIGITAL STORVTELLING

Digital Storytelling Production | CHIAPTER3

Adding titles and effects to photos

9. The "Add a title to your pictures” screen provides text
overlay on any image and, as shown in the following
figure, allows students to add a small amount of text to
any slide, especially to a first or title slide. An important
note for teachers: there is no spelling checker in this
application, so all text should be checked manually.

10,  Familiarize your students with the Customize Motion
options Motion and Duration, and Transition,

1. Have students learn how to lengthen the time each
slide is displayed on screen (at least 7 seconds is
needed). They can also control the Ken Burns Effect
of panning and zooming.

12, Students can click the Transition tab to apply or remove
transitions and to select a transition type.

13, Teachers, be sure to work with all of these tools
beforehand to decide how students can best take
advantage of all the special effects.
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Adding text to a slide in Photo Story
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Cuslomize Motion
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Adding transitions in Photo Stery

Adding narration and other sound

14. At this point in the program, students will have
the option of adding narration. {They will need a
microphone to record the narration.)

15.  Background music can be applied and previewed at the
next screen. The Create Music button is for applying the
wide variety of prepackaged music. The volume of the
music can be adjusted here,

Digital stories that incorporate special effects, music, and
narration will naturatly take students longer to produce.
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Creating the project video

16. At this point, students should stop and save their story
as a project (a WP3 file), prior to creating the video. If
they skip this step, they can't return to make changes,
corrections, or adjustments. So, insist on this saving step
before students move to the final screen! Students will
probably need mentoring during this process.

17.  Rendering the digital story into a movie format is the
final step. Before they do, students should read about
the choices available by clicking on the link “Learn
more about the selected choices,” which quickly opens
the Help file to the correct page. Please note that
as students click on each choice of how to save the
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18.

19.

movie file, an explanation of its technical requirements
appears.

Most of the time, students save their movie using the
“Save your story for playback on the computer” option.
When specifying the |ocation and filename of the
story, saving movies 1o the My Videos folder within the
My Documents folder is the logical choice and helps
students locate the project at a later time,

When students are ready to render the project into a
movie file format, they should click the Next button.
This process can take some time depending on the file’s
size, so plan accordingly. It is not something that can be
accomplished in the few seconds before the end of a
class period.
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Movie Maker

Movie Maker from Microsoft is a more complex application than
Photo Story, but after you have created your first digital story—
including the ePortfolio or photo essay variations—in Photo
Story you will be ready to work with Movie Maker. Remember
that movies rendered with Photo Story can be inserted into
Movie Maker as part of a larger production.

Like iMovie on the Macintosh, Movie Maker is a full-featured
video-editing and production application. This means that
students will have many more options for manipulating and
controlling the content. Although this can further empower
many students, the extra complexity can get in the way of others.
Additionally, video is much more demanding of computer
resources than still images. You'll want to set aside more time
for students to experiment with the application, but you'll also
need to ensure you have ample storage space for the video and
working files.
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Movie Maker Tutorial

Imagine that your students are involved in learning about the
pilgrims who traveled to America seeking religious freedom in a
new world. One of the goals of your month-long classroom unit
fs for students to understand what hardships, fears, and emotions
these travelers faced in their journey of survival.

As part of this, your students must create a virtual fieldtrip to
modern day Piymouth, Massachusetts, connecting the past with
the present for a better understanding of history.

For the preparation stage, students consider how the telling
and retelling of these stories has created legends, mistruths, and
modern-day contioversies.

Students investigate the “That's Plymouth Rock?” WebQuest
for background material (www.midgefrazel.net/wqprock.htmi)
then develop a timeline and create a story board as part of the
production process.

In the steps that follow, screenshots and instructions for Movie
Maker are for version 2. The older and yet-to-be-released versions
will differ, but should maintain the same basic functionality.

Importing photos for the project

1. Students gather needed media elements to create their

digital story and place them into a folder titled with the
name of the project.

2. Students open Movie Maker 2. From the File menu, they
choose Import into Collections.

3. Students use the Import File dialog box that appears to
navigate to the location of the student folder,
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Import file

My Metwork

Tmport options:
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Importing photos into Movie Maker

5.

Students choose the files they are going to Use, and
then click Import.

Once their files appear in their project, students save
and name their project by pulling down the File menu
and choosing “Save Project as...”

The Collection panel in the center of the screen holds
the media elements for the movie project. These
elements can be added to the timeline at the bottom
of the screen by using drag and drop. Students can add
more media elernents to this panel by using the same
method of importing them into their collection.

At this point, saving the project again is essential,
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Example Timeline view in Movie Maker

Arranging and editing photos

8.

10.

The timeline at the lower part of the screen is the heart
of the process of creating the movie. Students drag and
drop the elements {photos, sound clips, and music)
from their Collection panel into the timeline area. Media
items can be rearranged by dragging.

Each visual element can be viewed by clicking on it to
have it appear in the Monitor pane. Students can also
view the movie using the Play button in this Monitor
pane.

The bar in the timeline will move, showing where
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Adding titles and effects to photos

1.

12.

13.

14.
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Text slides can be placed at any point in a story.
Each movie should include at least a title slide and a
slide for credits at the end.

Students can type special text slides, like the poem
shown, in PowerPoint and export them as a JPEG file to
be used in the story.

Text slide display time must be lengthened to give the
audience ample opportunity to read the text or the
purpose will be lost.

Students should explore the choices available through
the Tools menu.
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students currently are in the viewing of the movie,
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R e 5T Creating the project video
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e — 17.  Saving the project before rendering the story to video
format is important, because no changes can be made
to the movie once it is created. But, if the project is

TIW PRI Fitherl, — where brs they?

e T saved correctly, the project files can be opened in
e Movie Maker again, changes made, and another movie
W) the Mavhower moored betow,

W T 1 ST W back with stormma, rendered.

And whits the thare with inow.

18. When students are ready to create the movie file, they
should pull down the File menu and choose "Save
Movie File...” The “Learn more about saving movie files”
link will help explain what the choices are,

19. Students should give the movie a name, choose a
saving location, and wait while the story is rendered
into a movie.

Adding Transitions in Movie Maker

20. The movie will be playable in Windows Media Player.

15, Students can apply special effects, such as transitions,
to enhance the mood of their story, but these should
be used sparingly. Transitions will appear in the et e ?"&
transitions line of the timeline so they can easily be
moved or deleted as needed.

16. Maovie clips can be added, and if the sound that
accompanies the video is not essential to the story, that @
track can be muted (by right-clicking the audio track in P Wit
the timeline and choosing Mute from the contextual
menu). By doing this, students can use a voice-over
narration, or music, with the motion of the video, easing
concerns about background chatter.

1 )

Rendering to a movie format in Movie Maker
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More Creativity Tools for Production

Although most digital stories can be produced and presented
with applications and tools readily available and affordable for
the classroom, it is wise for teachers to examine new creative
tools. There are plenty of choices in commercial software for
photo editing and video editing with pricing well under $100.
Although iMovie and Movie Maker are more than capable
free products, offerings from Adobe, Sony, Pinnacle, Corel,
and others can add valuable and fun features and capabilities,
especially for somewhat older and more advanced students.

In addition to commercial software, there are a number of web-
based products that can fit into your digital storytelling bag of
tricks. A couple I really like are Bubbleshare and Picnik.

Bubbleshare

Bubbleshare (www.bubbleshare.com) is an online tool for
sharing photo-based slide shows. It's a cool program and can
promote student interest in photography. Bubbleshare helps
groups of students decide which photographs are important to
their stories. It's not unusual for this selection process to take
students a long time as they decide which photos will have the
most impact with their story. The more simple the story, the less
time it will take.

Picnik

Picnik (www.picnik.com) is an online photo-editing tool. It is
easy to use, and it works well with photos hosted online and
with photos stored on the computer. There is a free version
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that provides basic photo manipulation, helping students move
quickly through the process of resizing, enhancing, and saving
photographs for their stories.

Creating and Editing Audio Files

Audio files are essential components of digital storytelling,
whether they accompany a series of images or, as in podcasts,
make up the digital story itself. Some useful podcasting websites
are listed in the Resources section at the end of this chapter.

The value of sound is not to be underestimated even in visually
based digital storytelling. Students should relate the music to
the story, rather than just adding their favorite music clips.
Remember, the point is to convey story with the use of just

the right combination of digital components. Sound effects
can also be a nice addition, as long as they don’t detract from
the narration or the music. Students tend to go overboard,
enthusiastically adding sound effects, music, and narration to
every project.

In addition to standing alone as digital stories, podcasts can
serve as a supplement or extension to a visually told digital
story, and as a source for gathering narrations. Podcasts can be
created using inexpensive microphones to capture narration or
interviews in MP3 format. This digital file can then be enhanced
with sound effect clips or music.
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Audacity

Audacity (http://audacity.sourceforge.net) is a free, open source
sound editor application that is commonly used for recording
narration and editing music. It is a cross-platform application
and is virtually identical in use for Macintosh, Windows, and
Linux users. Users download the application for their computer
platform from the information under the application’s Download
tab. Users will want to visit the Audacity Wiki page listed under
the Help tab. Here you will find tutorials and excellent directions
for creating a simple podcast using Audacity. Audacity-

related tutorials, tips, and instructions can be found at https://
academictech.doit.wisc.edu/orfi/avs/Modulesfaudacity.htm.

Be sure to download the LAME MP3 encoder (http:/lame.
sourceforge.net) so that you can export your music or podcast
as an MP3 file. This encoder is a plug-in, so install it to the
Audacity folder inside the Plug-ins folder.
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Audacity's audio-editing environment
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Resources

Production
iMovie: www.apple.com/ilife/imovie
Learning in Hand (Tony Vincent): http:/learninginhand.com

Photo Story: www.microsoft.com/windowsxp/using/
digitalphotography/photostory/

Movie Maker: www.microsoft.com/windowsxp/downloads/

updates/moviemaker2.mspx

“That’s Plymouth Rock?” WebQuest:
www.midgefrazel.net/wqprock.html

Creativity Tools for Production
Bubbleshare: www.bubbleshare.com
Picnik: www.picnik.com
Audacity: http://audacity.sourceforge.net

Audacity-related tutorials, tips, and instructions: https://
academictech.doit.wisc.edu/orfi/avs/Modules/audacity.htm

LAME MP3 encoder: http://lame.sourceforge.net

Podcasting
Poducate Me: Podcasting in Education: www.poducateme.com

Podcasting: How to Create a Podcast:
www.voices.com/podcasting.html

Podcasting Tools: www.podcasting-tools.com

Lessons Learned about Podcasting Microphones:
www.speedofcreativity.org/2008/01/06/lessons-learned-about-
podcasting-microphones
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PART I | Applying Digital Storytelling

As students prepare for their future, they must learn about
other places and different cultures, They must learn how to
relate to people who live and work in those places. The Internet
has narrowed the distance between classrooms, bringing them
together from around the globe. “Digital storytelling in the
community” may mean the local community, the national
community, or even a community on another continent.

Beyond the Classroom Walls

Global collaboration at the middle and high school level can
yield some terrific learning experiences with the ever-expanding
access to photographs, videos, and music that the Internet can
provide. Stories of places both near and far are being created,
transformed into video, and shared by K-12 students. Younger
students are eager to learn about the neighborhood around their
school, but as students get older, this neighborhood can extend,
via the Internet, beyond their town, city, state, or country.

Curriculum areas in social studies, such as geography and

local history, are a natural fit for digital storytelling in the local
community, bridging classroom to community. Students benefit
from the experience of exploring the world around their school
with the help of a digital or video camera. Researching local
heroes, both past and present, can result in digital stories rich
with oral history interviews, displays created for local museums
and libraries, and presentations given to community groups.

Community-based science projects can foster awareness of
local community issues such as recycling, conservation, and
beautification of community property. These projects can help
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students build a memorable and lifelong connection to their
community.

National or global issues such as

global warming, medical care, Digital Storytelling Ideas
for History, Science, and

nutrition, and dependency on
Community Issues

fossil fuels are a few examples of
current issues students can learn
more about through research .
and digital storytelling. And .

Community-based projects
Restoration of local parks
Study of local memorials

such projects can be a way for » Study of local architecture
students to feel actively involved a el
in issues they care about. Every « Hvestigation of local

rivers, ponds, and other
waterways

teacher can remember at least

one bored and apathetic student

who became engaged and

enthusiastic through making spicElbotiond serice
] ” helpers (fire police,

hands-on discoveries, and then medicall

* Local landscaping projects

sharing those discoveries with « Restoration oflocal
teachers and peers. historical graveyards

» Importance of affordable
Opportunities for connection housing

to the community through

curriculum-based projects

in digital storytelling could involve, for example, developing
mapping skills, learning about GPS technology, studying local
community laws, or exploring geophysical concepts. Applying
lessons learned in the classroom to community outreach projects
often helps bring learning to life for students in all grade levels.
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Place-Based Digital Storytelling

Making a connection between past and present is a concept
that some students struggle with and others find intriguing.
Here are just a few thoughts that can stimulate a classroom
discussion: Think of your own home, school, or neighborhood
as it looks today. Do you know how was it different in the past?
Can you imagine what it looked like? The notions that streets
were originally dirt paths, didn’t have sidewalks, or even had

a different name are the kinds of ideas that might stimulate
students’ imagination and a lively discussion.

An interesting related topic is that maps on paper are different
from online and GPS-created maps. Some students may wonder
how people managed to navigate without GPS, or at least an
online map that gives driving directions. Others may be eager to
share that their family still keeps paper maps in the glovebox and
gets around just fine.

Place-based digital storytelling, often called storymapping, is a
form of digital storytelling that uses online mapping tools such
as Google Maps (http://maps.google.com) or CommunityWalk
(www.communitywalk.com). Students choose a familiar area
nearby, or one they have previously visited (for example, on a
class fieldtrip), find it with the mapping tool, and create a digital
story in narrative form. Students place photos on the map, and
the story develops from the actual place.

Brenda Dyck has created a model of this mashup of mapping
and digital storytelling on her website: Find a Story ... Map a
Story ... Tell a Story (www.rebooting.ca/place/). Her project
idea is to have students locate a map of a memorable area, one
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they can tell a story about. Students place markers on the map
corresponding to parts of the story. On Brenda’s site, she offers
several examples of this combination of story and placeasa
digital experience, as well as step-by-step instructions for lesson
building and a suggested rubric.

Findastory.. Mapastory.. Tella Story..

4

Think of the first place you lived
The place you first went fo
school. The place you spent
summar vacations. The summer
you mat your best friend and the
nelghborhood that served as
your stomping ground..

These events and places are richin
mearning and full of memocias. There is
an interestng relalionship between
place, siory and comemunity. As we
revisit these places in our memory, we
realize how stories naturally attached
themseives to places from our past
and how they shape us in the present.

Brenda Dyck’s place-based storytelling web page

Annette Lamb and her husband Larry Johnson have created a
resource that builds on the place-based storytelling concept,
enhancing the learning experience through the use of GPS
devices (http://eduscapes.com/omrp/gps.htm). The GPS and

GIS technology brings virtual nature walks, or virtual walks
through history, into classrooms that may be far from such
places. Students who live in the city can now experience the
stories in literature where nature is a theme, or “visit” important
locations from their history books. Extended to global classroom
partnerships, this approach may become a new, collaborative
way to look at geography.
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Place-based Learning

Place-based education connects schools with the local community by grounding
leaming in local phenomena and kived experiences. Rogled in Dewey's focus on
authentic leaming, placed based approaches include cultural and historical studies,
nature exploration, and real-warld problem salving.

This idea of authentic, experiential ieaming also has roots in the Foxfire movement of
the 1960s stressing active learning, collaboration, reflection, creativity, and community
connections, The program focuses on 11 core practices that revolve around the idea
that “classrooms should be dynamic leaming sites where students and teachers work
as partners to meet the goals of the cumiculum”. Read about their eleven core practices
for teaching and leaming.

Read Michael L. Umphrey's 1 | i

j His anticle focuses on the need to develop education.centered
commusklies where students, teachers, and community members collaborate to build a
strong community. Umphrey advocates five approaches.

» Make community the focus of sefious study

« Use oralinferviewing

« Invite mentors to join

« Give “gifts of scholarship™ back to the community
» Establish an archives

Annette Lamb's place-based story web page

Cultural Digital Storytelling

In every community, and to some extent at every grade level,
students learn about cultures near and far. Whether itis a
standards-based activity meant to prepare students for test-
taking, or a supplement to other core-curriculum studies and
activities, student research into domestic or foreign cultures is
now supported by a growing collection of online resources that
can be applied in the students’ digital stories.

Rushton Hurley, founder of Next Vista for Learning (www.
nextvista.org), has created an online repository for educational
videos created by teachers and students. His website hosts a
growing variety of curriculum-based short videos. Hurley also
promotes digital storytelling in his presentations to educators
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at local and national conferences, encouraging teachers to work
with the wide variety of video-making applications to create
their own curriculum-based videos.

In his Light Bulbs collection, Hurley has created a video,
Introduction to Japanese Religion, for high school students and
their teachers as a basis for understanding how religion and
culture are strongly intertwined in the everyday life of the
Japanese people. This video could be used as an example of how
students might create stories that introduce globally significant
topics to their fellow classmates.

b NEXT VISTA FOR LEARNING
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Next Vista for Learning web page

Hurley has provided a way for educators to download the video
for offline use in the classroom (see figure above). Because many
of the other video-hosting web portals are often blocked by
schools’ content filtering, it is important for educators to be able
to freely download videos for offline viewing. The comments

DIGITAL STORYTLLLING | 137



PART 11 | Applying Digital Storytelling

section of Next Vista provides a way for educators to share how
they used these videos in their teaching.

Scientific Digital Storytelling

Students who are inspired by the wonder of nature and possess
natural curiosity about the scientific world will find their own
level of emotional connection to tell the stories of their future
plans for invention, medicine, and even saving our planet.

Weather, especially extreme weather, is a fascinating science
topic for many students. Storm science can tell us about the
history of our Earth, and it can also provide great material for
digital storytelling. Natural disasters and the events following
them provide stories about storms and the science behind them,
and also about the people these storms affect. After a storm has
ripped a community apart, stories about character, teamwork,
and community rebuilding are there to be told.

A project of this scope—and this is only one small idea—requires
fact-based evidence research and oral interviews. It also requires
a certain amount of imagination and creativity on the part of
the student. Ofien, it’s these kinds of challenges that engage and
motivate students who might otherwise have stayed slumped at
their desks.

Expanding on the ideas of using storm science as the basis of
a digital story project, students could visit their local library
or historical society to look for photos of the effects of extreme
weather in their own city or town. Conducting research in this
way helps students learn valuable archival and research skills.
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Also, local historians can be the voice telling the stories of
wintry blizzards, wild tornadoes, or hurricane devastation, and
how the community was rebuilt. Related stories might focus on
the prediction of ferocious storms, or on how people survive
them when they come. For example, New Englanders are fiercely
proud of stories of powerful hurricanes, humid summer heat,
and springtime blizzards. These stories have been passed down
orally, some for generations. Digital storytelling offers another
way to preserve such stories. Every community and family has
photographs and yarns to spin around the storm of such and
such a year.

Links to some good websites to search for photos of wild weather
can be found in the Resources section at the end of this chapter.

- . I

Wild weather example photbgraph
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Global Digital Storytelling

Students have a natural curiosity about the daily lives and
experiences of their peers in distant parts of the globe. If
children are starving or soldiers are dying, students often feel an
emotional connection to those unseen faces in unseen places.
Questions of global community are important in the lives of
today’s students, perhaps more so than in previous generations.
When seeking out a subject for this area of digital storytelling,

I suggest that you take a broad view of today's world issues.
Perhaps begin by posing a question to your students about one of
these issues or about an interesting area of the world. (Of course,
this work must fit with your curriculum content and should be
assessed on that basis.)

The Internet makes collaboration between classrooms possible,
even when those classrooms are on opposite sides of the

globe. Although there are always issues when conducting
multiclassroom projects, digital storytelling can make the
process more practical. Because an online digital story can be
presented asynchronously, time zone differences are minimized.
Additionally, digital stories, especially formats that rely
primarily or exclusively on images and video, can help bridge
language barriers.

Examples of these types of stories can be found at the Next Vista
for Learning website (www.nextvista.org), which includes Global
Views, a collection of videos about communities around the
world that were made by and for teenagers.
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Open-Ended Questions: Digital Storytelling and
Community

These sample open-ended questions are provided to give you,
the educator, ideas for developing critical thinking activities

to accompany digital storytelling projects. They are meant as
samples, and [ encourage you to make up your own that may
best fit your curriculum and your project. Consider the timeline
for each phase of the project and how the digital story will be
told before deciding on the guiding question.

» What is the best way to decide whether a particular
photo has historical significance?

» What questions might future generations have about the
digital stories we tell today?

+  What ideas do you have on how technology assists
teachers, parents, and students to learn more about local
and global geography as part of a better understanding
of the global economy?
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Resources
Historical and Cultural

Flickr—The Commons (publicly-held photography collections):
www.flickr.com/commons

Library of Congress Photos on Flickr: Frequently Asked Questions:

www.loc.govirr/print/flickr_pilot_faq.html

My Friend Flickr: A Match Made in Photo Heaven:
www.loc.gov/blog/?p=233

Next Vista for Learning: www.nextvista.org

Place-Based, or StoryMapping

Find a Story... Map a Story... Tell a Story...:
www.reboating.ca/place/

GPS and Place-Based Learning (Annette Lamb):
http://eduscapes.com/omrp/gps.htm

CommunityWalk: www.communitywalk.com

Google Maps: http://maps.google.com

Weather

Wild Weather, NOAA Weather Library: www.photolib.noaa.gov

Creative Commons: Search for Images:
http://search.creativecommons.org

Weather Links at Kathy Schrock’s Guide for Educators:
http://school.discoveryeducation.com/schrockguide/
weather.html
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A Final Word about
Digital Storytelling

We've used the phrase digital storytelling in this book to cover

a broad array of projects and products, including scrapbooks,
portfolios, class research projects, and independent research
projects. The digital tools available on the Internet as part of the
Web 2.0 family of open-source software have opened up a whole
new world for the application of hands-on learning in the K-12
classroom.

Classic digital storytelling applies the tools we have reviewed

in this book to bring classic storytelling, the written or oral
presentation of story, to life on the computer screen, shared with
the audience through further application of the technologies.

It is my firm hope that you will find the right application for
these tools in your classroom.
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